New Order Import profiles are used to load bibliographic records with embedded order data

True

False

New Order Import Profiles are used to load bib records with embedded order data
Which 2 of the following statements about New Order Import Profiles are correct?

- Cannot be used to create new purchase order lines
- Contain a mapping tab used to configure the mapping of funds
- Are used to load order information as well as bibliographic and inventory records
- Can create bibliographic records without creating inventory using the New Order Import Profile

Right! New Order Import Profiles contain a mapping tab used to configure the mapping of funds, and they can also be used to load order information, bibliographic and inventory records.
In order to add or edit Update Inventory Profiles, you will need either the Acquisitions Administrator or the Catalog Administrator Role in Alma.

Correct! While the Acquisitions Administrator Role allows you to view import profiles, only a Catalog Administrator can add or edit them.
Quiz: Update Inventory Profiles

Update Inventory Profiles

- Can only merge incoming bibliographic records and not overlay them.
- Can mark physical items received in the Inventory tab.
- Only update existing PO lines, bibliographic records and inventory records.
- Are used when the imported file has already been loaded, the purchase order lines for the records already exist, and the PO lines are linked to existing bibliographic and inventory records.
- Can create new records under certain circumstances.
Acquisitions workflows always require manual intervention

- True
- False

It is possible to fully automate acquisitions workflows
Default purchasing and invoicing rules

- Are read before the other rules in the list

- Are read before the other rules in purchasing review rules, but are read after the other rules in invoicing review and approval rules

Correct
Some of the parameters in Other Settings are not used unless Purchase Order Review Rules or Invoice Review Rules are configured.

- True
- False

For the parameters discussed in this session,
- `assertion_over_po_line_price` is only invoked if a Purchase Review Rule is configured to check the PO Line Price.
- `invoice_high_total_price` is only invoked if an Invoice Review Rule is configured to check the invoice's total price.
The Receiving Department Validations are applied to both physical and electronic items.

- True
- False

Receiving Department validations only apply to physical items.
The PO Line Packaging Job can be scheduled to run on a regular basis, or it can be run immediately as needed.

- True
- False

The PO Line Packaging Job can be scheduled to run on a regular basis, or it can be run immediately as needed.

Correct
A user with the General Systems Administrator Role can create a new library within an institution’s Alma:

- True
- False

Yes, a user with that role can create a new library, although a user with Fulfillment Administrator role cannot.
An institution that has only one physical campus should never have more than one campus in Alma.

True

False

Yes, this is false. Campuses are optional in Alma, but they could be used to group libraries for many purposes, including limiting e-resource access.
Typically, you would set standard open hours at the institution level, and then on the library level create the exceptions and events to modify those hours for each library.

Q True

F False

Yes, this is false. You set standard open hours at the library level. Then you can set exceptions and events at both the institution level and at the library level.
The Main Library is normally open 08:00 - 22:00. During final-exam week, it is open from 08:00 - 1:00 (an hour after midnight). In order to configure the open hours for final-exam week, how do you adjust the Main Library calendar?

- Enter a single Exception for open hours: 08:00 - 1:00.
- Enter two Exceptions for open hours: 22:00 - 23:59 and 00:00 - 01:00 for the next day.
- Edit the record with Standard when term break is over. Yes. Because of the way Exceptions override open hours, you’ll need to indicate the library is open during those two segments of time, including the early morning of the next day.
- None of the above
You want patrons to be able to request physical items owned by the Art Library to be delivered to – and checked out at – the Main Library. The following configuration(s) need to be set:

1. On the Main Library Relations Setup page, set Circulate For: Art Library.
2. On the Art Library Relations Setup page, set Circulate For: Main Library.
3. On the Art Library Relations Setup page, set Deliver To: Main Library.

Answers 1 and 3 above
You want physical materials at the Main Library to be available to loan to other institutions. Which library relationship(s) need to be configured?

- Main Library set to **Deliver To** Resource Sharing Library.
- Resource Sharing Library set to be **Supplied From** Main Library.

**Correct**

Yes. Items at the Main Library need to be **Delivered To** the Resource Sharing Library, and the Resource Sharing Library needs to have items **Supplied From** the Main Library for resource sharing purposes.
A circulation desk may be configured at:

- The library level
- The institution level
- Either the institution level or the library level, depending on whether it serves more than one library

Correct: Circulation desks can only be configured at the library level.
You may associate locations from more than one library with a given circulation desk.

- True
- False

Correct: You cannot associate a circulation desk with more than one library and, therefore, you cannot associate a circulation desk with locations at more than one library.
Every location (with physical items) in a library must receive the following service(s) from at least one circulation desk:

- **Check-in**
- **Check-out**
- **Re-shelve**

Correct: Every location with physical inventory must have all three services from at least one circulation desk, although each service could come from a different circulation desk.
A patron arrives at the circulation desk requesting to pay a fine or fee. The staff person logged into Alma cannot see a “Pay” option in the patron services menu of Alma. The possible reason(s) is (are):

- The staff person does not have the appropriate role.
- The circulation desk is not configured to accept any form of payment.
- The circulation desk is not configured to accept Online payment.

Correct: To pay a fine or fee, the circulation desk needs to be configured to accept payment, and the staff person must have the appropriate role.
Which one of the following statements is true?

- None of these statements is true.

A printer could be used by work-order groups at the institution level and those at the library level, but only if it has been configured at both the institution level and separately at each library where there are work-order groups that need it.

A printer configured at one library can be used by work-order groups at any other library but not at work-order groups configured at the institution level.

A printer configured at the institution level can be used by work-order groups organized at the institution level as well as work-order groups organized at any library within the institution.
A printer connected to a PC at a circulation desk, but not configured with its own email address, *can* be used for regular Alma printing jobs (such as hold slips and loan receipts) from that PC; but it *cannot* be used by any other circulation desks or service units at that library unless it has its own email address and is configured as an email printer.

Correct: All printers must be configured with an email address to be used as an Alma printer ... even one that is directly connected to a computer that is using Alma.
Quiz: Locations in the Alma Organization

Locations can be created within which of the following organizational levels in Alma? (Choose all that apply.)

- Campus
- Fulfillment Unit
- Institution
- Stand-alone (not associated with any other organizational level in Alma)
- Circulation Desk
- Library

Yes, locations can only be created at the Library level.

Correct
External Location Name is a required field when configuring a location in Alma, if you want patrons to be able to discover and request physical holdings from that location.

True  False

Yes, this statement is false. If you don’t enter an External Location Name, then Alma (and your discovery service) will show the Location Name to patrons.
The Accession Placement Field should only be used if you want to require all of your holdings records in a location to contain accession numbers.

- True
- False

Yes, this is one major effect of using the Accession Placement field. (The other is the ability to do a repository search on that MARC field in your Alma holdings records.)
Fulfillment configuration in Alma is based primarily on which of the following?

- Item Policy
- Location
- User Job Category
- Material Type

Yes. Although the other choices can be part of fulfillment configuration, Alma’s primary approach is to base fulfillment on locations.
A Fulfillment Unit is a group of similar locations, regardless which libraries the locations are in.

True

This is correct: Fulfillment Units are groups of locations whose physical items have similar terms-of-use policies.
The best-practice is to create Fulfillment Units on which organizational level in Alma?

- Location level
- Library level
- Institution level; except for a resource-sharing library, which should be on the library level
- Institution level

Yes. It is best to create fulfillment units on the institution level, except for those fulfillment units used by the resource-sharing library, which should be created on the library level.
When checking the applicable fulfillment-unit rules, Alma applies which rules?

- The first relevant rule, starting from the bottom, and then stops checking rules.
- The first relevant rule, starting from the top, and then stops checking rules.
- All relevant rules

Yes. Alma applies only the first relevant rule it encounters on the fulfillment rule list, starting at the top, and then doesn’t check any more rules below that rule.
In a theoretical library, locations associated with the General fulfillment unit allow items to be loaned to any user group, unless the item has item policy = 2. The General fulfillment unit contains the following rules:

- User Group = undergraduate student
- Item Policy = 2

How should these two rules be ordered in the General fulfillment unit so that the desired loan behavior occurs?

- The order of the rules is irrelevant.
- The Item Policy rule should be before (higher than) the User Group rule.
- The User Group rule should be before (higher than) the Item Policy rule.
The best-practice is to create Terms of Use on which organizational level in Alma?

- Location level
- Institution level
- Library level

Institution level; except for a resource-sharing library, which should have TOUs on the library level. Yes. It is best to create Terms of Use on the institution level, except for those Terms of Use used by the resource-sharing library, which should be created on the library level.
Which of the following entities can be created by staff with Administrator roles at your institution?

- [x] Terms of Use
- [x] Fulfillment Units
- [x] Policy Names / Values
- [ ] Policy Types

Correct. Administrators can create Terms of Use, Policy Names / Values, and Fulfillment Units. They cannot create Policy Types because that requires changes to the Alma software itself.
Policies are unique to each Terms of Use; they cannot be used in more than one Terms of Use.

- True
- False

Correct, this is false. Policies can be used in many different Terms of Use. Therefore, when editing or deleting policies, you can affect many TOUs.
Sue is a faculty member with loans due in a few days. A librarian told her the loans would be automatically renewed two days before the due date. But, two days before the due date, Sue receives an email from the library saying her loans are due in two days.

Which problem(s) might explain why Sue’s loans were not renewed?

- Automatic loan renewals are not configured properly.
- Sue’s loans have been recalled.
- The Send Courtesy Notices and Handle Loan Renewals Job did not run.
- Sue’s loans have reached the “maximum renewal period” – the maximum amount of time for a loan, including time added to the load by renewals.
Students and faculty are complaining that they always seem to have loans recalled early for the most popular items. How can you solve this problem for patrons?

- Change the IsRecallable setting in the Terms of Use for popular items.
- Nothing can be done to solve the problem.
- Modify the Loan Limits rule for students and faculty.
- Configure Loan Recalls so that general hold requests do not trigger recalls.
You want to send notices to undergraduates 7, 14, and 21 days after loans are due warning that the loans will be declared lost and a fine assessed if the loans are not returned within 28 days of their due dates. And, on the 28th day, you want Alma to change the loans’ statues to Lost, assess the fine and send a notification. To do this:

- Create one Overdue and Lost Loan Profile and specify the four dates within with profile.

- Only a single Overdue and Lost Loan notice can be sent per loan, so this is not possible.

- Create four separate Overdue and Lost Loan Profiles that include three **Overdue Notice Type** profiles (one each for days 7, 14, and 21) plus a **Change to Lost** profile for day 28.

- Create one Overdue and Lost Loan Profile and configure the **Overdue and Lost Loan Job** to run four times a day.
You want to customize the letter text differently for each of the Overdue notifications types [1-5] as well as the for the Change to lost letters. To do this, you need to click the Letter emails link on the General Tab of Alma Configuration and edit which of the following?

- Ful Overdue And Lost Loan Notification Letter
- Ful Overdue And Lost Loan Letter
- Ful User Loans Courtesy Letter
- Ful Lost Loan Notification Letter
- Ful Lost Loan Letter
Your patrons feel like they are getting spammed. If they have 10 overdue books due back on the same day, they get 10 separate Overdue and Lost Loan notifications. How can you get Alma to send a single notification listing all of the overdue books instead?

- Nothing can be done about this.
- Disable the **Overdue and Lost Loan Job**.
- Set some of your Overdue and Lost Loan Profiles to Active and others to Inactive.
- Change the Loan Terms of Use to limit notifications.

Make sure the `switch_to_overdue_and_lost_loan_new_job` parameter value is **true** under **Other Settings** in Fulfillment configuration.
The Anonymization Job protects user privacy by purging the following record types from the system:

- Loans
- Requests
- Fines and Fees
- Resource Sharing Requests

The correct answer is False.

Anonymization does not purge these records. Instead, anonymization severs the tie between these records and user records.

This protects user privacy while retaining important data for reporting in Alma Analytics.
How do you make sure that Alma anonymizes all four possible record types?

Activate and schedule the Anonymization Job, and check the boxes for anonymizing loans, fines and fees, and resource sharing requests. Also, go to Other Settings and set this parameter to true for loan requests:

- should_anonymize_requests

Go to Other Settings and set these four parameters to true:

- should_anonymize_loans
- should_anonymize_fines
- should_anonymize_requests
- should_anonymize_resource Sharing.

No action needs to be taken. Alma always anonymizes all four types of records, and you cannot change this.
Which of the following are Loan Anonymization Rule Input Parameters that you can use to specify the criteria for anonymizing loans?

- Days Since Loan Ended
- Days Since User Expiry
- Library
- Location
- Number of Loans to Retain
- Total Outstanding Fees and Fines

All but two are Input Parameters. The exceptions are:
- Loan Status
- Total Outstanding Fees and Fines

Alma never anonymizes active loans nor loans with active fees or fines, so these are not configurable Input Parameters for Loan Anonymization Rules.
You can open a case in the Ex Libris Knowledge Center if you need Ex Libris to restore user-specific data for anonymized loans in Alma Analytics.

- True
- False

The correct answer is False.

Anonymization permanently removes the tie between loan records and user records throughout the Alma system.

There is no way to recover or restore the anonymized data.
Community Users are entitled to borrow up to five items at a time, but only one of these items can be an Audio or Video Recording. To enforce this policy, you need to configure:

- Loan Limits
- Patron Limits
- Access Rights
- Item Policies

The correct answer is Loan Limits.

You can create Loan Limit Rules that restrict the number of concurrent loans allowed based on factors such as User Group and Material Type as well as Item Policy, Library, and Location.
Due to frequent complaints, your circulation department decided to no longer limit Booking Requests for faculty. To implement this policy, you can go to Patron Limits and change the “Max. bookings” value to 0 (zero) for the Faculty User Group. This will make the system ignore the Max. bookings parameter for Faculty only.

The correct answer is False.

To remove the Booking Requests restriction for faculty, delete the value in the “Max. bookings” on the Faculty User Group’s row. A blank parameter value tells Alma that there is no restriction to apply.

A 0 (zero) in the Max. bookings field for Faculty means that Alma will allow 0 (zero) bookings for Faculty!
Fulfillment: Block Preferences

Quiz: Cannot Override Block

Joe has the Circulation Desk Operator role. When he tries to check out an item to a patron, he sees the pop-up message with no override button. How might Joe resolve the problem for the patron?

User Smith, Nan is Blocked. Cash – Limit of 35.00 USD exceeded. User has 36.00 USD.

- Ask a Fulfillment Administrator to modify Block Preferences for this type of block.
- Ask a manager to check the book out to the patron.
- Ask the patron to pay at least part of the fees owed.
- Tell the patron that nothing can be done.
Quiz: Working with Handlers

You added a handler to a block as shown here:

- **Description:** Item is on Hold Shelf for this patron
- **Handler:** Delete the request and loan the item

Select all of the following statements that are true when you select the specified **Action** for the block.

**Override by Operator:** Staff with the following roles can override the block and take the action specified in the handler: Circulation Desk Manager and Circulation Desk Operator (but not Circulation Desk Operator–Limited).

**Block:** the block cannot be overridden. The handler will be ignored.

**Handle Automatically:** Alma will override the block and take the action specified in the handler.
Reference Librarians report that patrons are annoyed: Sometimes the Full text available link goes right to an article, and sometimes it goes to the View It section in Primo. They want the Full text available link to go right to full text more consistently. Can you help?

- No. There is nothing you can do.
- Yes. Go to the Direct Link Configuration page in Alma and enable direct linking.
- Yes. Go to Primo Back Office and enable direct linking.

But, reference librarians may also want to let patrons know that, if they are interested, they can see all their options and great details about the resource by clicking on the title.
Which of the following describe circumstances when you might want to turn off Direct Linking from the Full text available link so users will stop off at the View It section in Primo for more information. Select all possibilities.

- More than one full text service is available.
- A public note is available for a service.
- An article link is not available, but authentication is.
- An authentication note is available.

Right. The correct answer is:

All these choices describe circumstances when you might want to turn off Direct Linking.
Your reference librarians say students are confused by the text “Succeeds” next to related titles. They want the text changed to “Newer Title”. How can you do this?

**Services for Related Titles**

*Academic Pediatrics (Succeeds) (Newer Title)*

In the **Discovery Interface Labels** code table, edit the label description. Then, edit translations of the label for other activated languages.

Right. The correct answer is:

In the **Discovery Interface Labels** code table, edit the label description. Then, edit translations of the label for other activated languages.
Licenses for Electronic Services can only be seen by staff who can log into Alma. They are always private and cannot be displayed in Primo for patrons to see.

- True
- False

Right. The correct answer is: False.

Staff can log into to see license information in Alma. But, you can also configure licenses to display in Primo so patrons will know important terms of use such as whether making and sharing copies is permitted.
Which of the following relationship labels can appear next to services for **closely related** records? Check all that apply.

- [ ] Supplement
- [x] Part Of
- [x] Contains
- [ ] Precedes
- [ ] Succeeds
- [ ] Original Language
- [ ] Translation

Right. The correct answers are:

- Part of
- Contains

The other choices all describe related records, but they are not close relationships.
You don’t want guest users to be able to submit Requests for placing holds, but all other users should be able to do this. What should you do?

- Display Logic Rules do not work for the Request Service, so there is nothing you can do.

- Create a Display Logic Rule that hides the Request Service from users in the Guest User Group.

- Create a Display Logic Rule for each User Group that should see the Request Service for...

Right! The correct answer is:

Create a Display Logic Rule that hides the Request Service from users in the Guest User Group.
Display logic rules are created at the Institution Level. But, you can also create rules that apply to specific campuses. How does Alma determine the campus for a user? Select one or more answers.

- The user must specify a campus when signing into Primo.
- Alma compares the user’s IP Address to the IP ranges of the campuses configured in Alma.
- Alma checks for the campus affiliation in the user record.
- Alma does not support campus-specific Display Logic Rules, so the question does not make sense.
Which of the following statements is true about displaying General Electronic Services in Primo?

- In Alma, you can define your own General Electronic Services and use Alma to specify whether to show the services in the Get It and/or the View It section in Primo.

- General Electronic Services are predefined in Alma and you cannot change where they are displayed.

- When you define your own General Electronic Services in Alma, you must use Primo Back Office to specify whether to show the services in the Get It and/or the View It section in Primo.

Right! The correct answer is:

- In Alma, you can define your own General Electronic Services and use Alma to specify whether to show the services in the Get It and/or the View It section in Primo.
Imagine you only want to display a General Electronic Service when start page AND an ISSN are present in the Primo’s metadata for the resource. What should you do?

Create two Service Availability Rules: one rule with a parameter that checks metadata for existence of a start page, and one rule with a parameter that checks for an ISSN.

Create one Service Availability Rule with two parameters: one parameter that checks metadata for existence of a start page AND one that checks for an ISSN.

Alma cannot check Primo metadata, so there is no way to achieve this.
Many of the configuration parameters found on the Fulfillment Mapping Table cannot be found anywhere else in the Alma Configuration tool.

- True
- False

Correct. The Fulfillment Mapping Table is the only place many configuration parameters can be found.
You are in charge of formatting patron letter notifications. You don’t like the “Dear Sir/Madam” salutation in the letters and you want to change it to “Dear Mr./Ms.”. What should you do?

- Configure the mailReason.xsl letter in the Letter emails table.
- Disable the mailReason.xsl in the Letter Activity table.
- None of the above.
- It’s not possible to change the salutation in the letters in Alma.
- Open a Salesforce case and request an enhancement.

Correct! Use the Letter emails configuration table and locate the mailReason.xsl letter. Use the Row Actions Menu to customize the salutation for all of your letters in Alma.
Let’s say you then want the greeting in a specific letter to appear in bold font. How would you make that customization?

- Use the Letter emails configuration table.
- Use the Customize Letters configuration table.
- It’s not possible to change a specific letter in Alma.
- Open a Salesforce case and request an enhancement.
- None of the above.

Correct! Use the Customize Letters configuration table to modify, customize the XSL code for specific letters in Alma.
Which 2 “universal” XSL files will be important for you to configure for each of your letters in Alma before you send any notifications to patrons?

- footer.xsl Letter
- style.xsl Letter
- department.xsl
- mailReason.xsl Letter
- recordTitle.xsl Letter

Yes, the mailReason.xsl Letter and the footer.xsl Letter files will need to be customized. The mailReason.xsl Letter reflects the reason for the specific notification letter and the footer.xsl Letter contains important contact and account information specific to each letter.

Correct
Customizing the **addressFrom** setting in the Letter emails configuration table allows you to add a generic email address for the department in your library that is appropriate to that letter.

- True
- False

Yes, Use the Letter emails configuration table to customize the email address for the department in your library that is appropriate to that letter.
Which role is typically responsible for configuring mapping tables in Alma?

- User Manager
- Mapping Table Administrator
- Administrators (General System Administrators)
- General system operator

Yes, staff must have the General Systems Administrator role in order to configure mapping tables in Alma.
What 2 parameter configuration choices in the “Other Settings” mapping table?

- Configure
- Customize
- Remove
- Restore
- Delete

You can only Customize a setting in the mapping table or Restore the setting back to the original default setting.
All parameters are customizable in the “Other Settings” mapping table.

- True
- False

Correct! Some of the settings are no longer in use. Refer to the knowledge article in the Knowledge Center for details.
Imagine your email address is the “Preferred address” for a Sandbox user account, and you want to receive emails sent to that account. But, Alma Sandboxes are configured to prevent accidentally spamming anyone with an email address in the system. What should you do?

Right! The correct answer is:

- Add your email address to the list of Allowed Emails on your Alma Sandbox.

IMPORTANT: Do not remove the last entry in the Allowed Emails list on your Sandbox. If the list is empty, email will be enabled for everyone with an email address in the system!
What are some benefits of using the “Notification Template” tool rather than triggering an email to yourself to preview letter changes? (Select all that apply.)

- You have the flexibility of previewing letters either on screen or via email.
- When customizing a letter’s XSL, you can use the same XML file to preview the letter repeatedly. You don’t have to set up a workflow to trigger an email each time you edit the XSL.
- This is the most efficient way to preview changes to the static labels in Letter Emails.
- For letters that are difficult to trigger, you can get sample Letter XML from the Ex Libris Developer Network to use for previewing changes to a letter’s XSL.
Imagine you customized the XSL for a letter. Now you want to upload a Letter XML file into the “Notification Template” tool so you can see how the letter will look. How can you get Letter XML that includes your institution’s data? (Select all that apply.)

- You do not need to upload a Letter XML file when using the “Notification Template” tool.
- Download sample Letter XML from the Ex Libris Developer Network.
- Then, edit the values in the XML to reflect your institution’s data.
- Configure the “XML to Letter Admin” tool to email Letter XML to your email address any time that type of letter is sent to any recipient.
This Sandbox environment is populated with some of your production data and allows you to publish to your Primo Sandbox environment.

- Alma Ultimate Sandbox
- Alma Premium Sandbox
- Alma Practice Data Environment
- Alma Standard Sandbox

The Premium Sandbox is populated with a subset of your production data, allows you to publish to your Primo environment and is available after your go-live date.
Which 2 of the following statements are correct when requesting a Sandbox refresh?

- Simply call the Ex Libris Support team to schedule a refresh.
- The Sandbox refresh requires 60 days advance notification.
- The Sandbox refresh takes 1-2 weeks during which the Sandbox is available, but with slow or sluggish performance.
- Name of your institution and time frame for the refresh to occur.
- Refresh takes 1-2 days during which the Sandbox is unavailable.
The Sandbox Management page allows you to import/export records from your Sandbox to your production environment.

- True
- False

The Sandbox Management only contains some read-only information to help you understand the status of your sandbox environment.
Why is it critical to identify and populate an IP Restrictions Manager when configuring login restrictions?

Because the IP Restrictions Manager creates the error message that displays to the end user attempting to log into Alma from a restricted IP.

Because the IP Restrictions Manager receives any message sent by users when an attempt is made to access Alma from a restricted IP address.

The IP Restrictions Manager controls the IP addresses for the institution and therefore access to Alma.

Correct! The IP Restrictions Manager receives any message sent by users when an attempt is made to access Alma from a restricted IP address.
Which of the following statements about Work Orders are correct?

- Work Orders can be processed for physical items only.
- A Work Order is an internal library request to route physical materials to a specific department for internal processing.
- Library patrons are unable to view an item Status.
- There is no way to view items in process from within Alma.
- A Work Order is a list of daily activities my Library Director asks the staff to do.
Quiz: Work Order Department Configuration

Which of the following is NOT part of the Work Order Department 4-Step Configuration Wizard?

- Add General Department Information
- Add Contact Information
- Add Operators
- Attach Library
- Configure the Statuses

Status is configured in a specific Work Order Type.

Correct
Work Order Statuses are associated with Work Order Departments.

- True
- False

Work Order Statuses are associated with Work Order Types and are intended to reflect the step the item is undergoing while it’s being processed.

Correct
Which of the following statements is true about using the search by Keyword in the Alma UI Search? (choose one)

- Keyword searches only title-level fields
- Keyword searches a discrete set of search fields per index
- Keyword searches fields from all indexes

Correct! Keyword searches in Alma happen on a discrete set of search terms per index. Alma keyword search does not search on all fields from all indexes. Keyword searches are not limited to searching title fields, and can include the search of notes, descriptions and label fields.
The following Object Types are specific to Electronic Resources.
(choose all that apply)

- [ ] TPS/Collection
- [ ] Items
- [ ] Representations
- [ ] Holdings
- [ ] Portfolio

Correct! The TPS (or Collection) and Portfolio Objects contain index codes specific to Electronic inventory. The Item and Holdings Object Types are specific to Physical Indexes. The Representation Object types is associated with Digital Inventory.
In the Object Type Search Index Codes tables, all values in the column called Simple Search? are set to true by default.

- True
- False

Correct! In the Object Type Search Index Codes table, values in the column Adv.Search? are set to true by default. Values in the Simple Search? column are not set to true by default.
Which of the following options can be used to test normalization rules in Alma? (choose one)

- The Metadata Editor
- In an Integration Profile
- A Normalization Job
- An Import Profile

Correct! Normalization Rules are tested in the Metadata Editor using the split screen to test the rule against a test bib record. Normalization rules can be used to correct data when using an Import Profile, or an Integration profile such as OCLC connexion, but neither of these options is appropriate for testing rules. MARC21 Bib normalization jobs also use normalization rules to correct data, but not to test it.
Which of the following elements are required for normalization rules syntax? (choose two)

- Only one Action per rule is allowed (Then)
- Optional Conditions (When)
- One or more actions (Then)
- A Condition (When)

Correct! Required elements for normalization rules syntax include: a When statement (for conditions) and a Then statement (for one or more actions).
The most efficient way to create a Normalization Rule is to create your own rule from scratch.

False

Correct! While it is possible to create normalization rules from scratch, the best and most efficient way to create a normalization rule is to duplicate an existing rule from a template found in the MD Editor Rules area, or to use examples available in the Ex Libris Knowledge Center.
Normalization Processes are defined under the Normalization Processes tab within a Metadata Configuration (Profile).

Correct! Normalization Processes are added under the Normalization Process tab within the Metadata Configuration Profiles. (Alma Configuration > Resources > Cataloging > Metadata Configuration)
Which of the following statements about Normalization Processes is false? (choose one)

- A Normalization Process can only contain one normalization rule.
- Normalization Processes can be run as jobs.
- Normalization Processes can be used by import profiles.
- Normalization Processes can be used by external search resources.
- A Normalization Process can contain multiple normalization rules.

Correct! It is possible to have multiple normalization rules associated with a single normalization process. Additionally, normalization processes can be used when running jobs, and defined in import profiles or when importing records from external search.

Correct
Normalization processes are used only during bulk updates of records and cannot be used to update individual records in Alma.

- True
- False

Correct! Normalization processes can be used to correct individual bib records via the MD Editor and the Enhance this Record functionality – in addition to bulk import of records.
Which of the following actions is the result of using an indication rule on a set of records? (choose one)

- Indication rules are used to filter sets.
- Indication rules are used to combine sets.
- Indication rules are used to add members to sets.
- Indication rules are used to delete sets.

Correct! Indication Rules have only one function in Alma: They are used to filter records from existing sets.
In which of the following ways is it possible to create an indication rule. (choose two)

- Create an indication rule in the Admin menu under Manage Sets > add Indication Rule.

- Create a new indication rule in the Metadata Editor, under File > New > Indication Rules.

Correct! Indication rules can be created in the MD Editor from the File Menu by choosing New and then Indication Rule (File > New > Indication Rule). It is also possible to create an indication rule by duplicating an existing rule in the Metadata editor. (MD Editor > Rules > Indication Rules (folder) > Shared (folder) > (left click) Duplicate)
Indication rules use only indexed metadata elements when filtering sets.

- True
- False

Correct! Sets are created by building queries for indexed metadata. Indication rules can be written to use both indexed and non-indexed metadata to filter sets of records.
Which of the following statements is true of Match Methods? (choose one)

- Match Methods are only used when exporting records from Alma that will eventually be re-imported.
- Defining a Match Methods is a mandatory parameter when configuring an import profile.
- Match Methods can only used to find matching records for when records are imported in bulk.
- Match Methods help to identify when an imported record is a duplicate of a record already in the repository.
Match Methods can be customized for use in Alma.

- True
- False

Correct! Match Methods are pre-defined in the Alma system and are not configurable nor customizable. Choose one of the available out-of-the-box methods for use if desired.
The 001 to MMSID Match Method is used when it is necessary to match imported records to records that were previously exported from Alma.

True
False

Correct! The 001 to MMSID match method is chosen as the match method in the following cases. When records are exported from Alma, upon export, the MMSID is written to the 001 field and used as a match point when record is re-imported into Alma.
Quiz: Merge Methods Preferred Record

Which of the following statements are true about which record is defined as the preferred record when using Merge Methods? (choose two)

- The local repository record is always considered the preferred record.
- Fields from the preferred record are moved to the non-preferred record.
- An Imported record is preferred when using External Search.
- A Local record is preferred when using an import profile.
It is mandatory to configure a Merge Method if duplicate records exist in the repository or are being imported.

- True
- False

Correct! Merge Methods provide a mechanism to combine matching records when they are found in Alma, but using Merge Methods is not mandatory.
When matching bibliographic records are identified in Alma, Merge Methods can be used to define how the matched records will be merged into a single record.

True

False

Correct! Merge Methods are used to combine matching bib records into a single bibliographic record that may keep some fields from one record and overwrite others.
When the Match Actions - Handling Method is set to Manual (under the Match Profile tab for a Repository Import profile), any matching records found in the import profile will be set to a status of Manual Handling required.

**True**

**False**

Correct! When the Handling Method is set to Manual, records identified as matching are sent to the Resolve Import Issues page for staff review, and none of the other record-handling options are available for configuration.
When configuring a Repository Type Import profile, what are the physical-source format types that can be designated for the import file? (choose two)

- Binary
- XML
- FTP
- CSV

Correct! For the Repository-type profile details, the options available for physical source format are XML and Binary. CSV is a possible physical source format for a Digital type import profile, but not Repository type. FTP is an import protocol, not a source format.
The Set Management Tags options, under the Set Management Tags tab in the Repository Import Profile, are used to designate whether records will be published to a discovery system or not.

- True
- False

Correct! Configuration of Set Management Tags is used to determine if all records in the import profile will be published or suppressed for discovery.
Which of the following portfolio types is not associated with an electronic collection? (choose one)

- Standalone Portfolio
- Single Portfolio

Correct! The correct answer is Standalone Portfolio. When Part of an Electronic Collection is selected as a portfolio type, the option for single or multiple portfolios are available types. The Standalone portfolio type is not associated with an electronic collection.
In a repository import profile, when Electronic Inventory is selected under the inventory information tab, what portfolio types are available? (choose two)

- Mixed
- Standalone
- Part of an electronic collection
- Electronic

Correct! Standalone and Part of an electronic collection are the two portfolio types for Electronic inventory. Mixed and Electronic are options when selecting Inventory Operations.
In order for the Mapping tab to appear in the Import Profile, the only requirement is that the Map Library/location checkbox must be enabled.

- True
- False

Correct! It isn’t enough to select the Library/location checkbox (which will only show up when creating physical inventory). It is also necessary to save the profile after the Library/location checkbox is enabled.
When customizing the Metadata Profile for MARC21, which of the following options is not supported? (choose one)

- Assigning controlled vocabularies
- Making Subfields repeatable
- Configuring MARC tags as mandatory or not
- Adding Fields and Subfields
- Designating 1st and 2nd Indicators as mandatory or not
When data validation issues are identified in Alma, they are always assigned a severity-level message of "error."

- True
- False

Correct! In the Validation Severity profile, you may select either error or warning to indicate a default severity level. Errors must be resolved for validation errors, while warnings do not require resolution.
It is possible to assign a Controlled Vocabulary to a MARC field in Alma.

Correct! Controlled vocabularies can only be assigned to MARC subfields (such as 245 $$a) and not MARC fields (such as the 245).
Which of the following statements are not true about brief records levels in Alma? (select two)

- You can run an advanced search query of repository records to identify records with certain brief level values.
- A brief record level of 01 will prevent a record from being imported into the repository.
- It is possible to run a job on sets of brief records to update the brief level in bulk.
- Brief level rules help when overlaying brief records with full records during MD import.
- Brief records rules may not be customized; use only out-of-the-box rules.
Priority Statements, when included in the brief level rules, dictate the order in which rule logic is to be executed within the rule.

True

False

Correct! While using a priority statement is not mandatory for Brief level rules, priority statements do dictate the order (hierarchy) in which the parts of the rule are executed. If a priority statement is not used in the brief record level rules, the rules will be executed in the order in which they appear in the rule.
It is possible to view the Brief Level value of bibliographic records in the Metadata Editor under the Tools > Set Management Tags menu.

- True

Correct! To view the brief level of a bibliographic record, open the record in the MD Editor. The Brief Level (value) of the record will display.
What is the purpose of setting cataloging_level_user_preferences to the value True? (choose one)

- Define default behavior for cataloging levels in the MD Editor.
- Tell Alma to ignore the cataloging permission level for user.
- Activate the set cataloging jobs.
- Automatically set the highest cataloging permission level in the user record.
Jobs for setting cataloging level jobs in Alma will update which of the following types of records when they are run? (choose two)

- Authority Records
- User Records
- Item Records
- Holdings Records
- Bibliographic Records

Correct! There are two jobs in Alma to set Cataloging level: Set Bibliographic Records Cataloging Level, and Set Authority Records Cataloging Level.
Implementing Cataloging Permission levels is a required feature in Alma.

Correct! Creating and assigning cataloging permission levels is not required. Libraries that want to have more control over which cataloger can edit records may want to implement this feature.
Quiz: Publishing Profiles Parameters

Alma’s out-of-the-box Publishing Profiles can be used to export records to which 3rd party applications? (choose all that apply)

- [x] Google Scholar
- [x] OCLC Worldcat
- [x] Primo Central
- [x] Primo

Correct! Alma’s publishing profiles can export to all of the 3rd systems applications that are listed here as choices.
Quiz: Publishing Profiles Parameters

Which of the following parameters can be set in the Exclude Process Types from Publishing Mapping table? (choose two)

- Process Type
- Publishing Mode
- Material Type
- Originating System
- Output format

Correct! Records can be excluded from Publishing to Discovery by defining a Process Type (lost, missing or in process) and (optionally) a material type (book, CD-ROM). Output format, Publishing mode and Originating System are values set in the publishing profile and have no effect on exclude process types settings.
Full Publishing of Alma records should never be run after Alma Go-Live.

Correct! There may be circumstances that require full Alma publishing after Go-Live. When full publishing is run, only non-deleted records are published. Therefore it is important to discuss how to handle deleted records in such cases. Always discuss your options with Ex Libris Support before running full publishing when you are live with Alma.
Quiz: Description Templates

Description Templates format and display information coming from which of the following? (select one)

- Templates in the Metadata Editor
- The MARC description Field
- Physical Item Sort Routines
- The enum/chron tab in the Physical Item Editor
Barcodes can be added during which of the following steps in Alma? (select all that apply)

- [ ] When editing an invoice.
- [x] When adding a new physical item.
- [ ] When activating Portfolios.
- [x] When creating an order.
Alma’s Call Number Parsing Routines can be customized to suit individual library needs.

- True
- False

Correct! Existing parsing routines can be applied to any call number type, but the routines cannot be edited or customized.
Complete the following sentence: The Call-Number Mapping table allows customers to customize how the call numbers are mapped...
(choose one)

- from holdings records to bibliographic records.
- to export fields to support shelf reading.
- from bibliographic records to holdings records.
- from bibliographic records to item records.
- to multiple fields for spine-label printing.
The Call-Number Mapping table is used in the following areas (methods) in Alma. (select all correct answers)

- [ ] When the Copy 050 to 090 Job is run
- [x] When running an import profile job
- [x] When running the Update from Bibliographic tool in the MD editor
- [x] When the Change Holding Information job is run
It is possible to customize the Library/Location to display as code, or name, or code+name, for both the repository search results and in the Metadata Editor's bibliographic record.

False

Correct! Customizing library/location display offers the option to display code, or name, or code+name, in the repository search results, and in the holdings records in the MD Editor- not the bibliographic record.
Jacqueline is in charge of patron services. She wants to be certain that every new patron registering at the circulation desk receives an appropriate User Group. What does she need to do?

Ensure that the Mandatory Fields table for Public users includes the User Group field and that the appropriate User Groups appear in the User Record Type/User Group mapping table for the record type Public.

Ensure that the Mandatory Fields table for Staff users includes the User Group field and that the appropriate User Groups appear in the User Record Type/User Group mapping table for the record type Staff.

Configure User Registration Rules
Fulfillment Unit Rules such as Loan Rules can apply only to User Groups and not Job Categories.

The correct answer is False. You can configure the conditions when the rules apply, and both the User Group and Job Category fields are available.
We want to assign a staff role (e.g. circ desk operator, request operator, etc.) to a student. Which user record types may this student have to allow us to do this?

- Public
- Organization
- **Staff**
- Contact

Roles can be assigned freely to both Public and Staff users (but not to Contacts or Organization).
Dan is a guest user. His patron role has a scope of the Main Library.

In order to borrow items owned by the Science Library, Dan can:

- Request them for pickup at the Main Library
- Check out the item himself at the Science Library
- Cannot check out items owned by the Science Library

Dan cannot check out items owned by the Science Library, because his patron role does not have the appropriate scope. Pickup from the Main Library will not help in this case since that doesn’t change the ownership of the item by the Science Library. For this reason, patron roles usually have the scope of the entire institution, and limitations on checking out items are addressed through Terms-of-Use, Fulfillment Unit Rules and User Groups (Community, Special Borrower, etc.).

Correct
Jane is Responsible for assigning roles to staff users. She has created Role Profiles and used them to manually assign roles to current staff users. Since the current staff already have user records in Alma, Jane could have used Role Assignment Rules to assign the roles defined in the profiles automatically:

- **True**
- **False**

The Correct answer is False. Role Assignment Rules are applied only upon creating new users, and therefore do not help for existing users.
In the scenario above, Jane is asked to add the User Manager role to all current senior circulation staff. Since Jane assigned roles to the current staff by using a Role Profile, all she has to do is update her Profile with the User Manager role and this role will be added automatically to the existing senior circulation staff.

True

False

The Correct answer is False. Role Assignment Rules are static and are not linked to the User Record in any way. Therefore, any subsequent edits to a Profile after it has been assigned have no effect on the User Record.
You can use User Registration Rules to do which of the following? (Select all that apply.)

- [x] Assess a user registration fee.
- [ ] Assign roles to users.
- [x] Set the User Expiration Date of new user accounts (according to the User Renewal Period).
- [ ] Assign a User Group to a user.
You can configure the User Contact Information Pop-up as follows: It will display the office address for the Graduate Students group, but not for the Undergraduates group.

- True
- False

The correct answer is False. Different user-information can be displayed on basis of User Type (Staff, Public, and Contact), but not based on User Group. So you can have different pop-ups display for staff vs. students, but not for students vs. other students.
Quiz: Delete User Policy

You’ve attempted to purge an entire user Group called Former Employees, using the Purge User Records job, but no users were deleted. Which of the following are possible explanations?

- 🔴 The users do not have a purge date.
- ✔️ Your Delete User policy was set to Keep Statistics
- ✔️ The Purge User Records job was set to delete only Public users, and not Staff
- ✔️ The users all have outstanding loans
- ✔️ The users all still had Job Categories assigned to them
Alma can validate the following user fields using regular expressions:

- Emails
- Home Address
- Passwords
- Phone Numbers

All answers are correct! Even though we only discussed emails and passwords in this session, Alma can validate various other fields using regular expressions. You can find them all in the Other Settings mapping table.
User Management: Other Settings

User profile pictures must be stored in Alma.

True

False

The Correct answer is False. You may store the images on an external server, and configure Alma to fetch the photos from there.